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1.1 Important information

Last minute changes are documented in README.TXT

Support:
Fax inquiries: xx
By phone at: xx
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1.2 Abbreviations and Explanations

PTS = Paragon Technology Systems
DB = Drive Backup
PM = Partition Manager
BM = Boot Manager
CDM = CD Manager, CD-ROM Emulator (Manager)
DR = Any drive, either physical or logical.
OS = Operating System.

Applet: Program, appearing as tray bar icon.

Physical drive: Any physical drive (like hard drives, CD-ROM drives etc.)
Hard drive: A physical hard drive (the hardware).
CD-ROM drive: A physical CD-ROM drive that reads CD’s.
Virtual drive: A drive that is based in memory.
Virtual CD-ROM drive: A CD-ROM drive that is based in memory.
Logical Drive: Any logical addressable drive wherever it may reside (on a hard drive, CD-

ROM or in memory).
Logical drive identifier: The letters A thru Z.
Partition: A sequential portion of the hard drive, from track to track.

Primary Partition: A bootable partition, which, when set “active”, the partition table will 
recognize as “bootable”. Actually becomes bootable with an operating 
system installed.

Extended Partition: Not bootable, a framework (sub-section of the hard drive) within which we 
can create (multiple) logical drives. This area is recorded/tracked just like a 
primary partition within the partition table.
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1.3 About the program

1.3.1 Function / scope 
1.3.2 CD-ROM Emulator  ’  s functions and capabilities   
1.3.3 Benefits of using CD-ROM Emulator 
1.3.4 Personal and Network versions 

The hardware and OS requirements are: 
· Intel-compatible CPU, Pentium or better.
· Hard drive and CD-ROM drive.
· Windows 95/98, Windows NT 4.0 or Windows 2000.
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1.3.1 Function / scope

The CD-ROM Emulator has two main functions:
a) The creation of CD images and virtual CD-ROM drives .
b) Serving CD-based applications using CD images in virtual CD-ROM drives. (The memory-resident 

portion of CD-ROM Emulator).

A detailed outline of the available functions:
· Create CD images (from CDs) on hard drives 

o On boot drives
o On any other hard drive

· Create virtual CD-ROM drives 
o As many as there are logical drive letters available

· Make virtual CD-ROM drives available to the OS and applications 
o Auto-load virtual CD-ROM drives during OS startup

· Administer virtual CD-ROM drives
o “Insert” CD images into virtual CD-ROM drives
o “Eject” data from virtual CD-ROM drives
o Completely remove CD images from hard drives 
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1.3.2 CD-ROM Emulator’s functions and capabilities

CD-ROM Emulator makes it possible to work with CDs and CD-ROM drives without having the CDs 
and CD-ROM drives being physically present at all times. They need to be available only during the 
copy process of a CD image to a hard drive.
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1.3.3 Benefits of using CD-ROM Emulator

· Run CD applications without the physical presence of the original CD.
· Works using virtual CD-ROM drive(s).
· Allows access to (the data of) multiple CD’s simultaneously, despite only one CD-ROM drive being

present.
· Installable as a virtual server in a local area network.
· All virtual CD’s and their applications are available at all times.
· Access to virtual CD’s (installed on the hard drive) is significantly faster (up to 10 or 20 times) than 

the original CD’s.
· Lightning-quick switching from one CD to another (as opposed to manual switching of a data CD in

a CD-ROM drive).
· No more “hunting around” for misplaced CDs.
· Works with multiple “CD’s” at once, whether a real CD or drive is present or not.
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1.3.4 Personal and Network versions

CD-ROM Emulator is distributed as Personal and Network versions.

Personal version is designed for using in home environment where there is no Local Area Nerwork. 
There is no restriction in Personal version except for supporting multiple simultaneous using the same 
image file (which is not the case for home environment).

Network version is intended to be used in office environment on multiple workstations. This is normal 
case, when office administrator want to have CD server in Local Area Network. With Network version 
of CD-ROM Emulator you create CD images and place them on some “host” computer (normally file 
server), then set up access permissions for these images. After that CD-ROM Emulator from each 
workstation can use these images from “host” computer for inserting in virtual drives on workstations. 
This is feature of Network version of CD-ROM Emulator to allow simultaneous using of the same 
image file by multiple copies of CD-ROM Emulator (Personal version lacks this ability).

To determine which version do you have select About command in Help pulldown menu. In the 
appeared dialog you can see information about version number and version type of your copy of CD-
ROM Emulator.
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1.4 Program installation

This is a standard, familiar Windows installation. Simply run SETUP.EXE from the CD using Start | 
Run. The setup program then installs CD-ROM Emulator on your hard drive. 
Note: CD-ROM Emulator normally appears only as an applet (icon in system tray bar). Also, when the 
program is minimized, it returns back to an applet, rather than to the taskbar. For more information on 
this, please see: Section 3 - The virtual CD machine 
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1.5 Program execution

CD-ROM Emulator can be started in two ways, either manually by the user or automatically, when first 
starting the operating system.
1.5.1 Manual call by user 
1.5.2 Automatic start at Windows startup 

1. Introduction, installation, notes etc.. 



1.5.1 Manual call by user

For the creation and administration of CD images on hard drives as well as the creation of virtual CD-
ROM drives, CD-ROM Emulator must be called as an ordinary Windows program (Start | Programs, 
etc.). Alternately, since it is running in the background anyway you can start CD Mgr. from its applet by 
right-clicking the applet.
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1.5.2 Automatic start at Windows startup

To give the Windows OS access to the virtual CD-ROM drives, CD-ROM Emulator is started 
automatically during each boot of the Windows OS. This memory-resident portion of CD-ROM 
Emulator must be active in order for the OS and applications to access the virtual drives.

Note: This memory-resident portion of CD-ROM Emulator normally appears only as an applet. Also, 
when the program is minimized, it returns back to an applet, rather than to the taskbar. For more 
details see Section 3 The virtual CD machine .
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2. The CD-ROM Emulator interface

2.1 The working principles and parts of CD-ROM Emulator 
2.2 The main display
2.3 The Image Pulldown 
2.4 The Drive pulldown menu 
2.5 The View pulldown menu 
2.6 The Help pulldown menu 
2.7 CDDB 
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2.1 The working principles and parts of CD-ROM Emulator

Physical CD-ROM drives utilize CD “images” from actual physical data CDs.

CD-ROM Emulator likewise uses the same principle by placing the entire CD image (from an actual 
data CD) onto a hard drive. This CD image contains one or all tracks of the physical CD is and is called
the CD image. 

Virtual CD drives work with CD images the same way as real physical CD-ROM drives work with real 
physical CD disks, only the data can also be compressed to take up much less space than it did on the
CD it came from. Despite this, the access speed of a virtual drive is generally several times faster than 
a CD in a CD-ROM drive.

CD-ROM Emulator consists of two main parts. One part lets the user create CD images and virtual CD-
ROM drives.

The other part gives the Windows OS the ability to recognize and access those virtual CD-ROM drives.
This is done by loading the necessary CD-ROM Emulator drivers into the Windows startup 
configuration, and executing the TSR (terminate-stay-resident) portion of CD-ROM Emulator, that 
allows Windows and applications to access the virtual drives just like any other drive. All this is done 
automatically and is transparent to the user (once CD-ROM Emulator has been installed and the 
system restarted).

The TSR portion of CD-ROM Emulator normally appears only as an applet. Also, when the program is 
run and then minimized, it also returns back to an applet, rather than the taskbar. Changing the virtual 
drive configuration (by running CD-ROM Emulator) can be done by right-clicking this applet, which 
starts the user-interface portion of CD-ROM Emulator.

For more information on this, please see: Section 3 - The virtual CD machine .
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2.2 The main display

The main display consists of two main windows (panes), four pulldown menus and a toolbar.
2.2.1 The main windows 
2.2.2 The Toolbar 
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2.2.1 The main windows

The left window displays the actual physical and virtual CD drives present in the system.
The CD-ROM drives in the left windows are separated into two categories:
1. Paragon virtual CD-ROM drives.
2. Physical CD-ROM drives.

All Paragon virtual CD-ROM drives must first be created by the user while the physical CD-ROM drives
are all CD drives (and writers) found by the Windows operating system and set available to all window 
applications. 

The right window shows the CD images available to CD-ROM Emulator. This CD images in the right 
window must either be created or added to the CD-ROM Emulator. Each icon represents the contents 
of one original CD-ROM.

Icon with a question mark
If one of the images on the hard drive is moved or deleted, or the remote computer containing it 
becomes unavailable, CD-ROM Emulator will fail to recognize (“see”) the image, and the icon for that 
image is displayed with a question mark (“?”) on it.

Most of CD-ROM Emulator’s functions can be executed in one of three ways:
1. Through its option in the appropriate pulldown menu.
2. Using the function’s button on the toolbar.
3. By right-clicking the target, if it already exists.
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2.2.2 The Toolbar

The toolbar is the strip just below the pulldown menus, at the top of the CD-ROM Emulator windows. It 
contains shortcut “buttons” for the most common CD-ROM Emulator functions. The following identifies 
and explains the various buttons on the toolbar from left to right:

Button 1: Create a new CD image
Button 2: Eject an inserted CD image from its drive
Button 3: Add a CD image file
Button 4: Remove CD image file
Button 5: Add new (virtual) CD-ROM drive
Button 6: Remove (virtual) CD-ROM drive
Button 7: Edit CD image tracks
Button 8: Show CD image file properties

The exact functionality of the buttons is discussed in greater detail within each function’s respective 
“pulldown” section, below.
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2.3 The Image Pulldown

This pulldown deals with the creation and administration of CD images (virtual CDs) on hard drives and
it also has the program Exit function (Windows standard).

2.3.1 Insert a CD Image 
2.3.2 Create a CD Image 
2.3.3 Add a CD image 
2.3.4 Remove a CD image 
2.3.5 Image properties of CD image  
2.3.6 Rename a CD Image 
2.3.7 Editing CD tracks 
2.3.8 Change Icon 
2.3.9 Settings 

Note: Under normal circumstances, Create CD image is the function used. Add CD image is normally
used only to restore previously created images or images on another computer/drive, to register the 
CD image in the CD-ROM Emulator database.
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2.3.1 Insert a CD Image
(Image | Insert CD Image)

Purpose: Assign a CD image (“insert” the image in) to an existing virtual CD-ROM drive.

Alternate commands: Select Insert To CD Drive from the CD Drive pulldown or drag a CD image 
from the right window into a virtual CD-ROM drive in the left window. You can also right-click an 
existing CD image, then select the Insert option from the popup.

Requirements: A CD image to be inserted must be selected (A CD image must have been previously 
created using the Create a CD image function - see 2.3.2 , next function.) Also a virtual CD drive must 
exist as target. (Note: CD-ROM Emulator creates one empty virtual drive at installation – usually E:, 
and additional ones can be created using the CD Drive | Add New CD Drive command.)

Note: To understand more about how this works, please see the reference section: 6.1 Virtual CD-
ROM drives 

This command option is active only if a CD image is selected. If one is not selected, this option will be 
greyed-out.

If a valid CD image is selected, a dialog opens in which the selected CD image file is displayed. This 
dialog lets you select the target (virtual) drive. The CD image can thus be “inserted” to any of the 
empty virtual CD-ROM drives. After this, the image will be ready for use by Windows Explorer and any 
application program running under Windows, by simply selecting the virtual drive from an open or other
file dialog within the application program.

Icon with a question mark
If one of the images on the hard drive is moved or deleted, or the remote computer containing it 
becomes unavailable, CD-ROM Emulator will fail to recognize (“see”) the image, and the icon for that 
image is displayed with a question mark (“?”) on it.
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2.3.2 Create a CD Image
(Image | Create CD Image)

Purpose:
a) Transfer a CD image from a CD disc to a hard drive, or 
b) Create a Image from track image files (ISO, WAV, MP3), or
c) Build an image from files 

Requirements: In case of a) a physical CD ROM drive must be present, and an actual data CD 
inserted in that CD-ROM drive. There must be enough space on a hard drive to copy the CD onto 
(roughly, although the data will generally take up less space on the hard drive than on the original).

Shortcuts: First button on the toolbar. This function can also be executed by pressing the key 
sequence: CTRL + N.

This starts the “Create CD image” wizard which will lead you step-by-step through the process of 
transferring a CD image from a physical CD disk to the hard drive in the form of an image file.

Depending on the source there are different numbers of screens in the Create CD Image File wizard. 
In alls screens you can navigate forward and backward, using the < Back and Next > buttons. After 
you click the Create button the process of creating an image file is begun. The last screen shows a 
progress indicator.

Screen “Select source for CD Image”
a) Create CD image by copying a CD in a local CD-ROM drive
Check box “CD-ROM drive”; This shows all available CD-ROM drives using a pulldown list. Select the
physical CD-ROM drive to be copied from, if you have more than one (for example CD writer and 
reader). 

b) Create CD image from track files on any drive
Check box “track Image file”; This will show you all WAV, ISO and MP3 track. You may browse all 
available drives and directories with the <Browse> button. 

c) Create CD image from any files on any drive
Check box “build the image from arbitrary files” track Image file; This will not show an immediate 
reaction.

In all 3 cases press the Next > button to proceed. Depending on your selection the wizard will lead you
through the right sequence of steps to create a CD image.

Case a) Create a CD image by copying a CD from a CD-ROM drive

Screen “Select track(s) to be copied”
Shows the tracks on the selected CD. If there are more than one, select desired tracks. If there are 
multiple tracks to be copied, you can use the Select all button to copy all of them. 

This screen also shows you the estimated size of the image file to be created (in MB). You must have 
enough space on a hard drive for the copy to complete successfully. Click Next > to proceed to the 
next dialog box.



Note: In case of .WAV or MP3 tracks on the source CD you may use the CDDB capability of the 
program.
    
Screen “Select read mode”
You may choose different options to bypass different schemes of copy protections. You may check the 
boxes for
· raw read data tracks 
· try to access post-gap sectors 
· Ignore all bad sectors
 
Note: The “raw read mode” is not available on all CD-ROM drives and with all kind of CDs. This 
options are also one of the reasons why you can only read from a local CD-ROM drive and not from a 
remote network CD-ROM drive. 
 
In case of audio tracks You have following additional options:
· use jitter correction 
· ignore bad sectors
 
You also have the option to set the number of retries to read bad sectors.
Click Next > to proceed to the next dialog box.

Screen “Select compression ratio”
Allows you to vary the compression ratio of the data in the resulting image file (on the hard drive). The 
default is preset to the ”optimum compression to speed” ratio. To change it, drag the pointer in the 
slider bar in the desired direction. Higher compression results in less disk space occupied but also 
slower access to the virtual drive (and vice-versa). Keeping the default values is recommended.

Unchecking the Enable compression box results in an image file of the same size as the data CD and
also the fastest possible access to the resulting virtual drive.
Click Next > to proceed to the next dialog

Screen “Select hot key and drive for the new image”
This gives you the ability to assign a hot key and a drive to the new image. By pressing this assigned 
hot key the image will be automatically inserted to the specified drive. You may choose almost any key 
(except Return, ESC, Space etc.) or key combination. To select a key just press that key, for example 
F1, F2 or “STRG + S” and that key or key combination will be inserted. 
To select a specific virtual drive use the pulldown list which shows all available virtual CD-ROM drives. 
If you do not want a specific drive leave the selection on “any” dive.
Click Next > to proceed to the next dialog

Screen “Select target drive, path and name for the image file”
Shows the available target drives for the CD image and allows modification of the following target data:
· Target path and filename for the CD image.
· The desired target drive for selected data track(s).
· Assign alternate filenames for audio tracks.

By default, the filenames of the CD images will be DISK1.CDI, DISK2.CDI and so on (CDI stands for 
CD Image file) and will by default be created in the root of the drive with most available free space. The



default values supplied need not be changed unless you wish to change the target filename or location.
Prior creation of appropriate subdirectories/folders is recommended if many images are to be created.

Also, it may be necessary to create the CD image on a physical hard drive with enough space to 
accommodate the data to be copied. If uncertain, click < Back to screen two, to determine how much 
space the proposed CD image will occupy.

Now compare this figure to the free space on the target drive. The amount of free space on each hard 
drive is shown on this “Create CD Image” wizard dialog.

If audio tracks on the CD were selected to be copied and the Assign audio file names automatically 
box remains checked, the primary filenames of the resulting files will be identical to the primary names 
of the corresponding CDA files on the source CD. If any of the filenames are to be changed, uncheck 
the box and click the Change button to bring up the change filenames dialog.

Pressing the Create button begins creation of the CD image.

Note: Whether using the personal or network version, if multiple CD images are to be created, it is 
highly recommended that some sort of logical directory structure be first created on a drive with plenty 
of space, to accommodate the CD images to be transferred.

Case b) Create CD image from track files on any drive
After selecting the tracks in 
Screen “Select source for CD Image” 
click Next > to proceed to the next dialog

The “Create CD Image wizard” will bring you directly to the    
Screen “Select hotkey and drive for the new image”
Screen “Select target drive, path and name for the image file”
For detailed information about this screens see
Case a) Create CD image by copying a CD in a local CD-ROM drive

Case c) Create CD image from any files on any drive
After selecting the tracks in 
Screen “Select source for CD Image” 
click Next > to proceed to the next dialog

Screen for choosing an icon and image name 
In this screen you may choose an icon and a name for the image file you want to create from your files.
If you have own icons you may select one if them by pressing the <Change> button. This allows you to
browse through your directories and find and choose your icon.
    
To give your image file a name just overwrite the default name “CD volume label” with a name of your 
choice.
click Next > to proceed to the next dialog

Screen for choosing files for your CD image 
In this screen you select the contents of your CD image file. You may select whole directories or single 
files to be inserted. Just browse through all available drives and directories in the top window, choose 



the directories or files and drag them to the bottom window. When you finished click Next > to proceed 
to the next dialog

From here the “Create CD Image wizard” will bring you directly to the    
Screen “Select compression ratio”
Screen “Select hotkey and drive for the new image”
Screen “Select target drive, path and name for the image file”
For detailed information about this screens see
Case a) Create CD image by copying a CD in a local CD-ROM drive

Last screen “Create CD image”
This is primarily a progress indicator for the CD image creation process. Pressing the Cancel button 
will terminate creation of the selected CD image.
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2.3.3 Add a CD image
(Image | Add CD image)

Purpose: Add a CD image file to the CD-ROM Emulator database.

Shortcut: Button 3 on the toolbar. You can also right-click the background space of the right pane 
(window) to bring up a popup menu.

Note: Add CD image is used only to restore previously created images or images created by other 
clients on another computer/drive, to restore the CD image in the CD-ROM Emulator database.

When CD images are created (previous function, 2.2.2), they are automatically added to CD-ROM 
Emulator ’s database and displayed in the right window as an icon.

However, there are other instances when there is a CD image file which is not registered in the CD-
ROM Emulator database. This command is then used to restore or create the entry in CD-ROM 
Emulator ’s (administration) database.

Instances when this might be necessary:

1. After copying CD image(s) from other drives, to identify them.
2. To identify/register CD images on remote computers (as in a LAN).
3. After removing CD images from CD-ROM Emulator , to restore them from the still existing 

(physically present) image file (type CDI). This is somehow similar to a file “undelete”.
4. After complete removal and reinstallation of the entire CD-ROM Emulator application, to restore the 

CD image definitions to CD-ROM Emulator .

This command is very easy to use. It is simply a matter of opening the CDI file (CD image file) to be 
added to the database. Once added, the image file is displayed in the right window, and will be 
available for insertion into one of the created virtual CD-ROM drives.

A file open dialog is presented, which allows you to select a CD image file, (type CDI) to get CD data 
from. This file will have been previously created with CD-ROM Emulator , using the Create a CD 
Image function (see 2.3.2). This file can be anywhere on your local drive, or any remote computer 
recognized by your Windows configuration (see Network Neighborhood in Windows Explorer or My 
Computer).
The Network version allows an automatic update of the local image database. 

Use the Open dialog to select the CDI file (CD image file) to be added to CD-ROM Emulator . When 
the CD image file is identified and displayed in the File name field, click the Open button to add the 
CD image to the CD-ROM Emulator database.

Once selected/added, the CD image will immediately be displayed in the right window as a virtual CD 
available to CD-ROM Emulator . This image file will still have to be inserted into a virtual CD-ROM 
drive (see Section 2.3.1 Insert a CD Image), before it can be used by Windows and applications 
programs.

Icon with a question mark
If one of the images on the hard drive is later moved or deleted, or the remote computer containing it 



becomes unavailable, CD-ROM Emulator will fail to recognize (“see”) the image, and the icon for that 
image will be displayed with a question mark (“?”) on it.
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2.3.4 Remove a CD image
(Image | Remove CD image)

Purpose: Remove a CD image from CD-ROM Emulator (and optionally also from the hard drive).

Shortcuts: Press the third button on the toolbar, or right-click the CD image to be removed (right 
window pane) and click on Remove CD image…

This command is active only if a CD image has been selected . It removes the entry for a CD image 
from CD-ROM Emulator ’s internal database of virtual CDs. Upon selection, a confirmation dialog is 
displayed: CD image will be removed from the Emulator database.

The actual physical CD image will be deleted from the hard drive only if you select the Delete CD 
image file from physical disk option (box checked). If the box is unchecked, only the entry (icon, in 
the right window) for the CD image will be deleted, but the actual CDI file remains on the hard drive.

Click the OK button to remove the CD image entry (or the entry and its file, as selected), from CD-
ROM Emulator. The entry will disappear from the right window.

If this function is selected by mistake, but the file itself wasn’t deleted (Delete CD image file from 
physical disk was not checked), the entry can easily be restored by selecting the Add CD Image 
function (2.3.3).
If Delete CD image … was checked, the original CD may have to be re-read into the hard drive using 
the Create CD Image function (2.3.2). Check the Recycle Bin first. If the file can be restored, do so 
and then run the Add CD Image function (sec. 2.3.3). This will avoid having to reload the original CD.

2.3 The Image Pulldown 



2.3.5 Image properties of CD image 

Purpose: Shows information about a CD image and add a hotkey and a specific drive to an image.

Shortcuts: Press ALT + ENTER or open the context menu by right clicking the CD Image and then 
select Image property.

This option is available only if a CD Image has been selected. When selected, a dialog window 
displays information about the CD image on two selectable pages. The “General” page shows the 
name, path, image size, etc., and the “Track” page shows all tracks of the CD image. More information
can be shown for each track using the “Property” button.    

Beside this information pages there is a 3rd page which gives you the ability to assign a hotkey and a 
drive to any image. By pressing this hotkey, the image will be automatically inserted to the specified 
drive. You may choose almost any key (except Return, ESC, Space etc.) or key combination. To select 
a key just press that key, for example F1, F2 or “STRG + S” and that key or key combination will be 
inserted. 
 To select a specific virtual drive use the pulldown list which shows available virtual CD-ROM drives. If 
you do not want a specific drive leave the selection on “any” dive.
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2.3.6 Rename a CD Image

Purpose: Rename an existing CD image in CD-ROM Emulator.

Shortcuts: Press F2 or open the context menu by right-clicking the CD image and then selecting 
Rename.

This option is available only if a CD image has been selected. Keep in mind that this command 
renames the entry in the CD-ROM Emulator ’s Database only, not the actual filename at the operating 
system level. 

2.3 The Image Pulldown 



2.3.7 Editing CD tracks

Purpose: Adding, deleting, exporting tracks, to/from CD images. Also, converting images.
Shortcuts: Open the context menu by right-clicking the CD image and then select Edit tracks.

This option allows one to rearrange tracks within the boundaries of a specific CD image and also to 
import and export tracks in/out CD image file. This option is available only if a CD image has been 
selected. The following buttons are available:

a) Add (CD track) – <Add> button
Adds tracks from different files to the actual CD image. If pressed, the dialog for searching directories 
and files opens. Selecting a file in allowable format adds it to the current CD image. Allowable formats 
are: .iso image files, .wav and .mp3 audio files. For .iso image files a conversion will be held into 
internal CD-ROM Emulator format on adding it into CD-ROM Emulator image. Note: we treat .iso files 
as “iso image 2048 - Mode 1 Data Only”

b) Properties (of CD Track) - <Properties> button
If pressed, information about the CD image is displayed in a dialog window of two selectable pages. 
The “General” page shows the name, path, image size, etc. and the “Audio” page shows information 
about audio tracks, if present.

c) Delete (CD track) – <Delete > button
This removes the track from the CD image. The physical CD track image will be deleted from the hard 
drive only if you select the Delete track from physical disk option (box checked). 

d) Export (CD track) - <Export..> button
This is the opposite of a) Add CD tracks. This command let you save a track from CD-ROM Emulator 
image into a file on hard drive. After selecting a CD track, the <Export> button opens a window to 
select a target CD image file format (to which the selected track will be exported). You can export data 
track into .iso image file, and audio track (either in .wav or .mp3 format) into .wav file. If needed, a 
conversion will be held on exporting. Note: we treat .iso files as “iso image 2048 - Mode 1 Data Only”
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2.3.8 Change Icon

This option lets you replace an existing icon with an another one. The new icon must already exist. 
Select the icon to be replaced, taenables the replacement of an icon for a selected image file with your 
own icon. Your own icon must be already designed and ready for use. Activate the icon you want to 
replace, select <change icon> and start searching for your icon. When found choose it and this will 
replace the old icon with the new icon.

2.3 The Image Pulldown 



2.3.9 Settings

This menu option has 2 pages 
Page 1 the Interface page with 3 check boxes rules the display or hiding of windows. 

· Show the startup dialog
· Show the warning dialog when exiting the manager
· Show the tray icon

If any of this boxes is unchecked the window behind the respective box will be hidden. 

The CD-ROM drive page with 1check box
· Number of retries on bad sectors

This number tells the physical CD-ROM drive how often it should try to read a bad sector during a 
“create image operation”.
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2.4 The Drive pulldown menu

2.4.1 Insert To CD Drive  
2.4.2 Eject a CD image 
2.4.3 Create a virtual CD-ROM drive 
2.4.4 Remove virtual CD-ROM drive 
2.4.5 Drive Properties 
2.4.6 Explore 

This pulldown deals with managing virtual CD-ROM drives.

2. The CD-ROM Emulator interface 



2.4.1 Insert To CD Drive 

(CD Drive | Insert to CD-Drive)

Purpose: Insert a CD image to a virtual CD-ROM drive.

Alternate commands: In the Image pulldown, select Insert CD image, or click on a CD image in the 
right window and drag it to a virtual CD-ROM drive (in the left window). These two functions are 
essentially identical, therefore please see Section 2.3.1 for more information on this function.

Note this function is active only when an empty virtual CD is selected as target. A dialog window opens 
in which the selected virtual CD-ROM drive is displayed. The pulldown window Insert virtual CD 
image file lets you select any available CD image (in the right window). The selected CD image is then
“inserted” into the initially selected target virtual CD-ROM drive by clicking OK .

The CD image name is displayed in the left window (after the virtual CD it was inserted into).

2.4 The Drive pulldown menu 



2.4.2 Eject a CD image
(CD Drive | Eject)

Purpose: Remove (“eject”) a CD image from a virtual CD-ROM drive, to free up the drive for 
another CD image.

Shortcuts: A right-click on the virtual CD drive offers the Eject option. A double-click on the virtual 
CD-ROM drive will also instantly eject any inserted CD image.

This command option is only active when a virtual CD-ROM drive with an inserted CD image has been 
selected. Upon execution of this function, the inserted CD image will be ejected from the virtual drive 
without any further confirmation, but will remain in the right window to show that the CD image is still 
available to be inserted into a virtual CD drive again later.

2.4 The Drive pulldown menu 



2.4.3 Create a virtual CD-ROM drive
(CD Drive | Add new CD Drive)

Purpose: Create a new virtual CD-ROM drive.

Shortcut: Fourth button on the toolbar. You can also right-click any existing virtual CD, or right-click 
the parent item, Paragon virtual CD-ROMs to create a new virtual CD. If either of these 
items is selected, a right-click anywhere in the left window offers this option as well.

A windows with following dialog options appears:
- Choose Drive letter: Default is the next free drive letter
- Mount for this session only: Default is No (box is not checked): CD-ROM drive will not be recreated 
during the next system start up (if box is checked).

Or choose the Automount option

Mount drive for this user only: drive will be visible for this user only.
Mount drive for all users (at system startup): Drive is available to all users.

This automount option is sufficient for network version of CD-ROM Emulator (however, can be used in 
any case). For the first case (Mount for this user) the virtual drive will be created and mounted after 
user logon the system. For the second case (Mount at system startup) the virtual drive will be created 
during system initializing (before any user logon the system). So in the second case the virtual drive 
will be available for all users (in countercase – only for current user). For network version it’s 
recommended to use second option: the system makes any local resource shared at system startup. If 
a virtual device is created with first option (Mount for this user only) and then shared, the sharing 
information will be cleared upon nearest system shutdown or restart.

Note: If your particular CDROM drive has an image on network drive you should use “Mount drive for 
this user only”, because if this option is not used – CD-ROM Emulator will try to insert CDROM image 
at system startup when the system hasn’t yet mount network drive and will fail in inserting virtual CD.

After pressing OK the virtual CD-ROM drive will be created.

Use this function when multiple virtual CDs are needed online simultaneously, as in a virtual CD server 
in a LAN (see section 5 on that topic). Anytime you need more than one virtual CD at your fingertips, a 
new virtual CD drive must be created (for each CD image to have at your immediate disposal). Each 
CD image to be accessed must be inserted into one of these created virtual drives (see 2.3.1 , 2.4.1 ).

2.4 The Drive pulldown menu 



2.4.4 Remove virtual CD-ROM drive
(CD Drive | Remove CD Drive)

Purpose: Delete an existing virtual CD-ROM drive.

Shortcut: The fifth button on the toolbar, or a right-click on the target virtual CD-ROM drive in the left 
window.

This command removes a virtual CD-ROM drive from CD-ROM Emulator.

Caution: When this function is executed, the selected virtual CD-ROM drive will be deleted 
immediately and without any further confirmation. Any CD image data it contained, will no longer be 
accessible to the OS or any application programs which had pointers to this virtual drive.

Data (CD image) is not affected
The CD image which was in the virtual drive is not affected. It remains on the hard drive. Also the 
image will still remain recognized by CD-ROM Emulator (stay in the right window). The image can then
be reinserted into another virtual CD-ROM drive at a later time.

2.4 The Drive pulldown menu 



2.4.5 Drive Properties

Purpose: Parameter settings per individual virtual CD-ROM drive.

This command option is active only if a virtual CD-ROM drive has been selected. 

This Dialog window contains 2 tabs 
1) Tab “Mount” with following dialog options:
Mount for this session only: Default is No (box is not checked) : CD-ROM drive will not be recreated 
during the next system start up.

Or choose the Automount option

Mount drive for this user only: drive will not be visible to any other user.
Mount drive for all users (at system startup): Drive is available to all users.

2) Tab “Insert” with following optins:
Insert Image at logon/Start up: If checked a CD Image is inserted at every start up or logon.
CD-Image (to be inserted). Select the CD image for automatic insert during start up.

2.4 The Drive pulldown menu 



2.4.6 Explore

This option is only active on a CD-ROM drive with an inserted image. It shows all available data about 
the inserted image like number of tracks etc.

2.4 The Drive pulldown menu 



2.5 The View pulldown menu

2.5.1 Enable/disable toolbar 
2.5.2 Display/hide Status Bar 
2.5.3 View CD images as Large Icons 
2.5.4 View CD images as Small Icons 
2.5.5 Refresh window contents 

2. The CD-ROM Emulator interface 



2.5.1 Enable/disable toolbar
(View | Toolbar)

Purpose: Enable/disable the toolbar.

Enables (and displays) or disables (hides) the toolbar. The toolbar is the strip just below the pulldown 
menus, at the top of the CD-ROM Emulator window. It contains shortcut “buttons” for the most 
common CD Mgr functions.

If a checkmark is displayed next to this option, the toolbar is displayed and active. In this case, clicking 
this option will turn it off (hide the toolbar). If no checkmark is displayed then the toolbar will not be 
visible either. In this case, clicking this option results in turning it on. A checkmark will be displayed next
to the option and the toolbar will be displayed and its functions made available to the user.

For a screenshot of the toolbar that shows the various buttons and their function, please refer to 
Section 2.2.2 The Toolbar .

2.5 The View pulldown menu 



2.5.2 Display/hide Status Bar
(View | Status Bar)

Purpose: Hide or redisplay the status bar.

Displays or hides the status bar at the bottom of the CD-ROM Emulator window. The status bar 
displays a longer explanation of a function, button or other item that is too long to be displayed, when 
the mouse is “held/hovering over” that item or button.

When you hover the mouse over a button on the toolbar, a more detailed explanation of its function will
be displayed on the status bar. When you hover the mouse over a CD image (icon, in the right 
window), the status bar shows the full path and file name of the object (CDI file). Also, when a function 
is in progress, the status bar will usually display what is being done.

If a checkmark is displayed next to this option, the status bar is displayed and active. In this case, 
clicking this option will turn it off (hide the status bar). If no checkmark is displayed then the status bar 
will not be visible either. In this case, clicking this option results in turning it on. A checkmark will be 
displayed next to the option and the status bar made active.
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2.5.3 View CD images as Large Icons
(View | Large Icons)

The available CD image files (CDI files), in the right window, can be displayed either as large icons or 
small icons (but not both). Both these (mutually exclusive) options are displayed on the View pulldown,
and a circular bullet appears next to the currently active option. There will be a bullet next to only one 
of the two options, since they cannot both be selected at the same time.

This is similar to the corresponding view options in Windows Explorer and various Microsoft application
programs using dialogs that involve files and/or shortcuts.
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2.5.4 View CD images as Small Icons
(View | Small Icons)

Please see the previous section (2.5.3 ), for a complete explanation of these two options.

2.5 The View pulldown menu 



2.5.5 Refresh window contents
(View | Refresh)

Shortcut: Press the F5 function key. This function key and its resulting effect is a Windows standard 
convention.

If for some reason, the virtual CD configuration is changed (virtual CDs or CD images added or 
removed) and the changes are not reflected in either the left or right window of CD-ROM Emulator, use
View | Refresh to redisplay the contents of both windows with the new, updated information. As noted, 
the F5 function key will yield the same results according to Windows standard convention.

2.5 The View pulldown menu 



2.6 The Help pulldown menu

This pull down menu has 2 options
Contents with a complete help system for CD-ROM Emulator.
and 
About… which displays information about CD-ROM Emulator as there are:
version number of CD-ROM Emulator version type (Personal or Network) that you are running, phone 
numbers and web addresses of Paragon, for customer support, as well as the copyright.

2. The CD-ROM Emulator interface 



2.7 CDDB

The pulldown menu has following options

2.7.1 Enable CDDB 
2.7.2 About CDDB 
2.7.3 Register User 
2.7.4 Update Registration 
2.7.5 Proxy Settings 
2.7.6 Flush cache 

CD-related data through the Internet from the CDDB™ Music CD Database. Copyright 1999, 2000 
CDDB Inc. CDDB Client Software. Copyright 1999, 2000 CDDB Inc.

CDDB-Enabled, CDDB, CDDB2 and the CDDB Logo are trademarks of CDDB, Inc. Disc Recognition 
Service and DRS are service marks of CDDB, Inc.
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2.7.1 Enable CDDB

This is a flip-flop switch; Any time you click it switches from one state to the other one (from ON to OFF
and from OFF to ON). If checked CDDB will work. If you do not want any information about your audio 
CDs or if you do not have Internet access set this switch on off. 

2.7 CDDB 



2.7.2 About CDDB

CDDB is a Recognition Service for audio CDs. It is based on a database of CD text information, used 
for CD recognition purposes and it works only with CDDB-enabled player. This CDDB enabled players 
will access the Internet server(s) which contain that CDDB database to identify the Audio CD and 
download all information about that specific CD. If there is no internet access the CDDB will not work. 

2.7 CDDB



2.7.3 Register User

To register, run the CDDB-enabled application. If it is the first time you access CDDB, the CDDB 
Registration Wizard appears automatically. Follow the screens for a "New Registration" to select a 
"nickname" and password. The remaining information is optional, but does help CDDB provide better 
service. 
Once you have registered, you should never have to register again, unless you want to use CDDB 
from a different computer, in which case you only need to type in your "nickname" and password again.

2.7 CDDB



2.7.4 Update Registration

At any time, you can update your registration information, change your privacy settings, or delete any 
registration information you have established for your Nickname. 
To change your registration information or settings, enter your Nickname and Password and change 
the desired settings. When you complete the re-registration process, this information will replace any 
registration information stored by the CDDB server.

2.7 CDDB



2.7.5 Proxy Settings

Proxy settings are standard options for browsing the Internet and downloading files. You can specify 
them in all programs that use the Internet (Netscape Communicator, Internet Explorer, download 
managers etc.). If you use a proxy server you must set the proxy server settings so that the CDDB 
client will be able to connect to the external servers through a proxy server.

2.7 CDDB



2.7.6 Flush cache

All CDDB clients use cache to store some downloaded information locally – this avoids repeat 
downloads of identical information. To force CDDB for a new download use his menu point which will 
flush the CDDB client cache. An empty cache forces the CDDB service for a new download. 

2.7 CDDB



3. The network version

The Paragon CD Emulator offers    four different network versions.
· Private network version
· Network version without license control
· Network version with license control
· Network version for terminal servers.

            
                      These different network versions    serve different market needs in
                      functionality.

· The private network version is very simple to install and can be used to share CD Images 
on a private    network by two clients at the same time. Therefore this “simplest” network 
version is comparatively inexpensive.    Contrary to the personal version this network version
runs also on Windows NT/2000 servers.

· The network    version without licenses control  has all necessary functions that are 
needed    in middle/large network environments. A centralized CD Image database makes all
CD Images stored    on any network drive instantly available to all CD Emulator clients.    
This version has    also additional Administrator functionalities. There are    only “legal” 
licensing restrictions – no technical restrictions are limiting the    number of CD Emulator 
clients.    Therefore this Network version is usually delivered under the terms of Open or 
Enterprise-wide License.

· Network version with License Control. Exactly the same functionality as the    network 
version without License control but with a tracking mechanism    that controls the    number    
of accesses    to CD images.

· Network Version for Terminal Servers. This version provides additionally    virtual CD 
drives for Terminal Server clients. Therefore additional administration functions for a 
Terminal Server are available.

3.1 Installing the    CD Emulator network versions in dialog mode 
3.2 Configuration of CD Emulator network versions 
3.3 Using CD Emulator on a Terminal Server 
3.4 Installation of network versions in    batch mode 

Paragon CD-ROM Emulator 



3.1 Installing the    CD Emulator network versions in dialog mode

When you start the installation, there comes a message designating the exact version name.

Installation of    private network version 
Installation of Network version 
Installation of Terminal Server version 

3. The network version 



3.1.1. Installation of    private network version

The private network version installation does not differ from the installation of    the personal version 
of CD Emulator. You should install the version on the two clients which will use CD images across 
the network. The Installation asks for a serial number    and    the same serial number should be used
for both clients. After installation each client can    create CD Images and store them on any network 
drive as well as      mount them into their virtual CD-ROM drives.

3.1 Installing the    CD Emulator network versions in dialog mode 



3.1.2. Installation of Network version

The Network version    requires two installations: the administrator installation and the installation on 
all clients. The installation asks in all cases    if you want to install an administrator    or client version.

The administrator version can be used to create CD images and manage them in a network. It can 
be any workstation with a physical CD-ROM    drive and access to the file server. The created 
images may be stored locally or on a file server.    Additionally, in a network version with license 
control the administrator version of CD Emulator tracks the numbers of connections to CD images. 

The difference between the administrator and the client installation is that the client installation does 
not install the additional administrator functionality.    To identify    an    already installed version on a 
particular computer, look in the 'About' dialog window of CD Emulator. 

Installation    of network versions with    license control 
Installation    of    Network version without License Control 

3.1 Installing the    CD Emulator network versions in dialog mode 



3.1.2.1 Installation    of network versions with    license control

In this case you must install the Administrator module first.
· The user name and serial number will be asked, be aware that both fields are case sensitive.
· The installation asks then    to specify a folder where    the license account file should be created. 

This file is required for    license control. It is very important that the account file should reside in a 
folder which is accessible as a network resource for all computers running the    network version of 
CD Emulator. This resource must    be available with READ/WRITE access rights.

· After selecting a folder for    the license account file the installation of CD Emulator Administrator 
will proceed. When finished    you    must reboot the system. CD Emulator will run automatically and
will try to create a license account file. If something goes    wrong    you    have specified an invalid 
path or a previous file can't be overwritten    or you don't have write access rights for that folder. In 
all this cases    you need to reinstall CD Emulator.

Note: Only user with administrator privileges can install CD Emulator on Windows NT/WIN 2000.

Installation of    client versions of CD Emulator.
During the installation of a client version you will be asked only to specify the path where the license 
account file is stored (this file was created during the installation of the administrator version).    No 
additional information is needed. After completion you will be asked to reboot the system. You have to 
do this first reboot by using the same user profile. 
Note: user name and serial number are taken from the license account file.

3.1.2. Installation of Network version 



3.1.2.2 Installation    of    Network version without License Control

This installation is almost identical with the    version with License Control.    The only difference is that 
the administrator version is not creating a license control file and therefore each    installation of a client 
will ask    again for the    user name and the serial key.

3.1.2. Installation of Network version 



3.1.3 Installation    of Terminal Server version

The User Name and Serial key will be asked. Enter these data carefully because both fields are case 
sensitive. Note that only user with administrator privileges can install CD Emulator on Terminal Server 
(either log in locally or through a console). The installation will automatically install CD Emulator for all 
users on the server. It is necessary that CD Emulator is being installed for all users, otherwise the 
service will be accessible for the administrator only. CD Emulator manager will differ in its behaviour for
different users. For users with administrative privileges CD Emulator will behave like a administrator 
version part of CD Emulator network version with license control. For all other users CD Emulator will 
behave like a client    of CD Emulator Network with License Control. 

3.1 Installing the    CD Emulator network versions in dialog mode 



3.2 Configuration of CD Emulator network versions

After the installation of the administrator and client components some additional settings    should be 
done to be able to use the features    of the network version.

· Central directory and database for shared images
· Administrator settings on clients
· License control settings (if necessary)

Centralized database for CD images (shared images) 
Administrator settings on the Client 
Network version with license control 

3. The network version 



3.2.1 Centralized database for CD images (shared images)

Every CD Emulator client has a database with “shortcuts” to CD Image files stored locally or on any 
remote network drive. This shortcuts to CD Images are    either added automatically during the creation
of a CD Image or    manually by adding    a CD Image.    
To automate these adding of shortcuts, the network version of CD Emulator has an additional 
centralized database of “shared” images. These images are located in a shared directory. The name 
of this    directory can be entered on any client      through the menu item “Shared images” in the    pull-
down menu    Administrator> . This directory should be the same for all clients and administrator 
installations in a network.    It is recommended to use UNC (universal name conversion format)    to 
make it independent from the drive mapping.

How do shared images work?
CD Emulator dynamically scans the contents of    the directory    with the shared images and creates      
shortcuts to these images. The shortcut will have the word “shared” in the image status bar (for 
example, “q:\netcde\msdn.cdi Shared”). Therefore, as soon as a new CD Image is created in the 
directory with shared images, it will be recognized by all other CD Emulator clients and will 
automatically appear as a shortcut.    

CD images in the directory with shared images can only be created and deleted (edited etc.) by a user 
with write access to that directory. If that directory is shared for all clients    with    read/write access 
then all CD emulator clients can create new shared CD images.

Any CD emulator client or administrator that creates a new CD Image will create a static (not shared) 
shortcut    in its database to this CD image, wherever it may be stored.    If this image is created in the 
directory for shared images, this new CD image will appear on    all clients in the network as a shared 
image      except for the client/administrator which created it. The reason is,    that the scanning of CD 
images in the directory for shared images adds only shortcuts to shared CD images that do not yet 
exist in the clients database as a static shortcut.    Shared images cannot be renamed or deleted, 
therefore managing shared images can only be done by the client/administrator in which this shared 
image is shown as a static (not    shared) image.    

3.2 Configuration of CD Emulator network versions 



3.2.2 Administrator settings on the Client

The client installation of CD Emulator has additional options. These options are mainly    to restrict the 
functionality of client and include:
· The right to create new CD Images
· The right to add/delete CD Images
· The right to edit CD Images
· The right to add/remove virtual CD-ROM drives
· The right to change virtual CD-ROM drive properties.

By default, all these functions are disabled for any client, so that a client is limited to use shared CD 
images only.

To change these options select the pull-down menu “Administrator” -> menu item “Options” on the 
Client version of CD Emulator and enter the password to access the options. By default the password 
is empty.

To change the password select the pull-down menu “Administrator” -> menu item “Change Password”

Note:    The Administrator options are different for different users of    a computer (workstation) because 
they are saved separately for each user. Every time you change these options, you change them for 
the currently logged in user. Only the administrator password is unique    for any given computer.

3.2 Configuration of CD Emulator network versions 



3.2.3 Network version with license control

The network version with license control utilizes a special mechanism to track the number of CD 
Emulator users currently using network CD Images. The mechanism uses the License Account File 
and the Master ID.

License Account File.
This file is created during the installation of    the Administrator part of CD Emulator. The user selects 
the path where this file will be created. This    license account file should be accessible with    read and 
write privileges to all clients with    CD emulator.    It is recommended to use the UNC path to avoid any 
problems with drive mapping.    The installation of any CD    emulator client asks for the path where this 
License Account file is stored.

The license account file contains information about all CD Emulator clients using network CD images. 
When the number of clients exceeds the number of licenses, the next client access will be denied.

As soon as a CD emulator client tries to insert    a non local CD image file    for the first time, a special 
entry will be created for this client in the license account file. It indicates that license for that client is 
used. The client is identified through a unique number generated from the NIC (network card). The 
administrator installation contains a special “Monitoring Utility“ to view the state of this file.

If    a CD emulator client cannot locate the license account file during its start, there will be a warning 
displayed that only local CD images will be accessible. As soon as the license account file is available 
(or the network connection is available again) the network CD images can be used again. It is 
important for users of notebooks that CD Emulator still works with local images when no network 
connection is available.

Master ID
All network CD images created by a network version with License control are singed with a master ID. 
This master ID is unique for every    CD emulator administrator installation and is intended to 
distinguish network CD images for different installations of CD emulator. The client or administrator 
part of the CD Emulator can only work with network CD images with a appropriate master ID. If the 
master ID does not fit, it can be changed by the administrator. 
This manual change of the master ID    avoids the    re-building of CD images created by    an another 
version of CD Emulator or by an another administrator. The change the master ID for one or all CD 
images    can be done in the pull-down menu Administrator.



Note: There is Read/Write access required to change the master ID of a CD image.

3.2 Configuration of CD Emulator network versions 



3.3 Using CD Emulator on a Terminal Server

There is a special CD Emulator network version for Terminal Server (TS Version). CD Emulator, when 
installed on a terminal server    allows the creation of virtual CD-ROM drives and the inserting of    CD 
images    for different sessions and users.

CD Emulator versions designed for normal Windows OS (not a terminal server) can create “System-
wide” visible virtual CD-ROM drives as well as virtual CD-ROM drives that are visible to one single 
user only. The table below illustrates the difference of global and local virtual CROM drives for different
OS’s and    the Terminal Server version.

Terminal Server can also be used    as a file server for storing CD Images and we actually recommend 
this configuration because users working with terminal server console do not have any additional 
performance effects    -    the CD Images are local.

Virtual drive type Windows 9x/ME/NT/2000 Windows 2000 Terminal Server
----------------------------------------------------------------------------------------------------------------------------------------
---
System-wide virtual 
CDROM drive

Appears for all users using the
same drive letter.

Appears for all sessions and users of 
Terminal Server using the same drive 
letter.

----------------------------------------------------------------------------------------------------------------------------------------
---
“For this user only” 
virtual CDROM drive

Appears only when current 
user is logged in.

This virtual CDROM drive works only 
during current session. If user logged onto 
the terminal server twice on different 
console, he/she does not see virtual 
CDROM drive created in an another 
session.

3. The network version 



3.4 Installation of network versions in    batch mode

You can install Network version with or without license control and    network version for terminal server
in silent mode (batch mode). This works by starting the setup with a parameter that forces the 
installation routines to bypass all dialog screens and read all parameters from an external file. 
This enables completely automated installations on a number of workstations (together with    Windows
Networking logon scripts). 

To install the program in silent mode    the files silent.ini and setup.iss are required. The file setup.iss is 
supplied together with the installation and cannot be changed. The file silent.ini contains all individual 
parameters (destination folder, program group name etc.) for a specific installation and    may be 
changed according to your needs.
Create silent.ini file automatically 
Edit silent.ini file manually 
Install in Batch mode 
Installation using logon scripts 

3. The network version 



3.4.1 Create silent.ini file automatically

To create the file silent.ini you should perform a full installation in dialog mode with the key 
/sw<IniPath>. <IniPath> - is the full path (without any brackets and quotation marks) to the directory in
which silent.ini file will be created. If <IniPath> is absent, the file will be created in the same directory 
were the Setup.exe file resides. After a correct installation all    parameters entered during the 
installation will be stored in the file silent.ini.

Examples:
setup /sw      -    starts the installation and saves the    entered parameters in the    file Silent.ini located 
in default directory (where setup.exe is).

setup /swc:\my directory – starts the installation and saves the    entered parameters in the    file 
Silent.ini located in “C:\My directory” directory.

3.4 Installation of network versions in    batch mode 



3.4.2 Edit silent.ini file manually

The file Silent.ini    has    following format:

[SetupType]
Admin=0

[Registration]
UserName=User
SerialKey=12345-12345-12345-12345

[Folders]
Shared=c:\
Target=C:\Program Files\Paragon Software\Paragon CD Emulator Network
AccountFilePath=c:\

[ProgramGroup]
Name=Paragon CD Emulator Network
Personal=0

[Finish]
Reboot=0
LaunchApp=1

You can edit    any of    the    parameters.

Description of parameters:
SetupType field:

Admin – define type of installation (0 =    setup as Client and 1 = setup as administrator) 

Registration field:
UserName – your User Name
SerialKey – your Serial Key

Folders field:
Shared – assign folder where you want to store the shared images
Target – destination installation directory
AccountFilePath – Account file path (it is used by version with License Control)

ProgramGroup field:
Name - Program group name
Personal - assign type of Program Group (0 – for all user, 1 – for this user only)

Finish field:
Reboot – assign behaviour after installation (0 – do not reboot computer, 1 – reboot ).            

            LaunchApp – launch or do not launch the application after



            installation (0 – do not, this parameter is ignored if Reboot=1)

3.4 Installation of network versions in    batch mode 



3.4.3 Install in Batch mode

To install CD Emulator in batch (silent) mode you should start up setup.exe with    following parameters:
/s /f2<LogFile> /sr<IniPath> key.    /f2<LogFile> - specifies an alternate location and name of the log 
file created by InstallShield . By default, if this key is absent the Setup.log log file is created and stored 
in the directory were setup.inx    resides.
<IniPath> - is the full path    name (without any brackets and quotation marks) to the directory in which 
silent.ini file is located. If <IniPath> is absent, the file will be searched in the directory were the 
setup.exe file resides.

Examples:
setup /s /sr      -    start up installation in silent mode with silent.ini,    silent.log,    setup.log located in 
default directory (where setup.exe is). 

setup /f2”c:\My directory\Setup1.log” /src:\My directory - start up installation in silent mode with    
silent.ini,    silent.log and setup1.log located in “c:\My directory” directory.

Note: The CD-ROM emulator installation in silent mode creates a    protocol    in two files. The first file 
is defined by    the /F2 key (by default the setup.log    file is created and stored in the same directory as  
setup.inx).    The second file is    silent.log which will be created    in the same directory    were the 
silent.ini    file resides.    If    there are any problem send these 2 files to support@penreader.com.

3.4 Installation of network versions in    batch mode 



3.4.4 Installation using logon scripts

Logon scripts are a standard way for automated administration in Windows NT networks. Below we 
describe how to use them in the case of an automated installation of CD Emulator on multiple 
computers (workstations).

To use logon scripts you should have a domain network administered by Windows NT or 2000 domain 
controller.

The Windows NT    server resource kit contains an utility named    Kixtart. You will need the file 
kix32.exe on the server. For Windows 9x workstations you will need to place the files kx16.dll, kx32.dll 
and kx5.dll into the system directory (C:\windows\system).

In the user manager you may then specify logon scripts. Specify the necessary script file (or create 
new ones with one command only) and insert there the call for the    Kixtart utility with a specially 
prepared script file: kix32.exe cdemul.kix. The main difficulty with using plain logon scripts is that these
scripts are performed on server locally. The Kixtart utility bypasses this difficulties and allows the 
execution of    commands on a user’s workstations during the logon procedure. 

You can find detailed description of    the syntax for Kixtart scripts in the resource kit help files.

3.4 Installation of network versions in    batch mode 



4. Operations – Step-by-step Instructions

This chapter supplements the manual with step-by-step instructions of how to execute the functions of 
CD-ROM Emulator. It is also meant to serve as a reference and as such refers to the functions and 
options in Section 2 and the examples in Section 5 .
4.1 Copying a CD image to a hard drive 
4.2 Creating virtual CD-ROM drives 
4.3 Connecting CD images with virtual CD-ROM drives 
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4.1 Copying a CD image to a hard drive

This refers to the following functions/sections of the manual
Section 2.3.2 Create a CD image.

Note: In order to create a new CD image on a hard drive, the size of the selected CD must not exceed
the size of the available remaining space on the target hard drive. You can use compression for 
creating an image, but a priori it’s not known how much will compression decrease an image size.

Step 1: Insert the CD disc to be copied into a physical CD–ROM drive.
Step 2: Start the Create CD Image File wizard by clicking the first button on the toolbar, or from the 

Image pulldown.
Step 3: Select the CD-ROM drive with the inserted CD.
Step 4: Select (click on) the track(s) to be copied to hard drive.
Step 5: Select the compression level with the slider-bar.
Step 6: Enter a name for the CD image and select the drive and path where this CD image should be 

stored.
Step 7: Click the Create button to create the CD image.

For more detailed information, see Section 2.3.2 .
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4.2 Creating virtual CD-ROM drives

This refers to the following functions/sections of the manual:
Section 2.4.3 Create a virtual CD-ROM drive 

This is a very simple one-step command. Execute the Add New CD Drive function from the CDROM 
Drive pulldown, or by clicking the 2nd button from the right, on the toolbar. Unless a physical CD is 
selected, a right-click anywhere in the left window also offers this option from a popup.

A new virtual CD-ROM drive is created with the next available drive letter, without any further 
confirmation.
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4.3 Inserting/Ejecting CD images to/from virtual CD-ROM drives 

a) Insert a CD Image
The simplest way to insert a CD image is the “drag and drop method”; simply pick the desired CD 
image with your mouse, drag it to the desired virtual CD-ROM drive and drop it there – it is inserted.

b) Eject a CD Image
This is even simpler, Double-clicking the CD-ROM drive with the inserted CD-image will immediately 
eject the CD Image.

See also the following functions to insert/eject:
Section 2.3.1 Insert a CD image , and:
Section 2.4.1 Insert To CD Drive 
Section 2.4.2 Eject 
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4.4 Virtual CD-ROM drive letters and Autoinsert of CD images

Drive letters are assigned during the creation process of virtual CD-ROM drives, they can not be 
changed afterward. By default the next free letter is used, but you can choose any other letter not yet in
use. For more details see section 2.4.3 Add new CD Drive .

For each virtual CD-ROM drive there is the possibility for an automatic insert of cd-images during 
system startup. For more details see section 2.4.5 Drive Properties .
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5. Examples of working with CD-ROM Emulator

5.1 Set up virtual CD server, Windows 9x/NT 
5.2 Set up client 
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5.1 Set up virtual CD server, Windows 9x/NT

This section is for system administrators (or any user) using a local area network.

All CDs which are to be addressed as virtual CDs, system-wide, for various clients, should be loaded 
onto the “host” computer (file server, for example), using the Create a CD Image function (Section 
2.3.2 ) to create the necessary CDI files on the host computer. (These files need not be inserted to a 
virtual CD drive on the host. This is done from the client.)

The CDI files should be given meaningful file names and can be created anywhere on the host drive, 
so long as the filenames and locations are recorded for subsequent set up of the client systems. If 
there are a multitude of virtual CD’s to be installed, creative usage of separate subdirectories is 
recommended, to organize the CDs in major subdivisions. For example, you may wish to use names 
like: C:\CDImages\Games, C:\CDImages\Utilities, etc. Each CDI file should be created in the 
appropriate subdirectory.

Next, make certain that the intended clients have the necessary directory and file permissions to 
access the CD image files they should have access to. Virtual CDs can subsequently be addressed by 
the client machines as defined in the next section: 5.2 Set up client 
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5.2 Set up client

Virtual CDs on another computer (“host”, containing the CD images) can be addressed by the client 
machines in the following manner:

First of all, a separate copy of Paragon CD Manager should be installed on each “workstation” which is
to access virtual CDs on a remote “host”. In the case of different access permissions for different 
workstations, each client will have its own particular set of virtual CDs defined for that user.
Adding a CD image (known remote path) 
Adding a CD image (remote path not known) 
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Adding a CD image (known remote path)

Note: If the exact location of CD image files is not known, follow the directions in the next section 
(remote path not known), to find them and then come back here to finish setting up remote virtual CD
images.

Use the Image | Add CD image function. 

In the Open dialog window, click the pulldown arrow to the right of the Look in window and select 
Network Neighborhood. (Note: If this item is not present, you’re not properly connected to a working local
area network or other computer.)

In Network Neighborhood, double-click the name of the computer and then the name of the hard drive 
with the CDI file(s). In this example, the computer name is COMPUTER 2 and the hard drive name is 
MAX. Keep selecting until you have selected the directory and filename to use.

If you know the full path (including the computer and hard drive name), instead of using Look in to 
keep clicking down the tree, you can type the full path in the File name field. In our example, the full 
path is:
\\COMPUTER 2\MAX\disk1.cdi. If the path to the CDI file (CD image file) is not known, please follow 
the instructions in the next section to find CDI files on a remote computer.

When the CD image file is identified and displayed in the File name field, click the Open button to add 
the CD image to the CD Manager database.

Finally, use the Insert CD Image function (see Section 2.3.1 ), to put the data of the newly found CD 
images into an empty virtual CD-ROM drive. If an empty virtual CD-ROM drive doesn’t exist, one must 
first be created. (See section 2.4.3 Create a virtual CD-ROM drive ).

Windows Explorer and other Windows application programs will now be able to access the CD’s using 
the drive letter of the virtual drive (which the CD image(s) were inserted to), as shown in the left 
window of CD Manager.
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Adding a CD image (remote path not known)

If you’re not sure where the CDI files are, contact your system administrator, or use the Find | Files or 
Folders… function (Start button) of Windows to locate them as follows:

In the Find dialog, select the local or remote drive(s) to be searched.

If you’re searching for CD images on a remote computer, click the Browse… button, and in the 
Browse for Folder window, scroll down to Network Neighborhood. (Note: If this item is not present, 
you’re not properly connected to a working Local Area Network or other computer.)

Click the plus (+) next to Network Neighborhood to expand the tree, then click the plus next to the 
computer to be searched. Finally, click the drive (on that computer), to be searched, then click the OK 
button.

In the Named field (filename), enter the file designator *.CDI. Make sure the Include Subfolders option is
on (box checked). Make note of the filenames and paths which the Find function displays, to use them 
subsequently in the Add CD image function.

CD Manager by default, creates CDI files in the root of a hard drive. Examples of full paths/filenames 
created by CD Manager (by default) are: C:\DISK1.CDI and C:\DISK2.CDI (that’s CD”eye” not 
CD”one”).

If your search was successful, you should now have a list of available CD image files and the full paths
to them. See the previous section, Adding a CD image (known remote path) and follow the 
instructions for creating virtual CD’s from another computer.

5.2 Set up client (attach to other peer) 





6. Reference section

6.1 Virtual CDs and virtual CD-ROM drives 
6.2 Command line control of CD-ROM Emulator 
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6.1 Virtual CDs and virtual CD-ROM drives

As mentioned in the introduction, physical CDs, as well as CD Manager, uses a CD image file for data 
storage. This is usually in the form of a single file (track) per CD. CD Manager stores this CD image as 
a single file on a hard drive. By default, this file is called DISK1.CDI, DISK2.CDI, and so on, and is 
placed in the root of the C: drive. These files are referred to as CD image files.

CD Manager also allows you to create one or more virtual CD drives. Just like real physical CD-ROM 
drives, each of these virtual drives has the capacity to insert, play and eject a CD. Only with virtual 
drives, the inserted CDs are the CD image files (type .CDI). These virtual CDs, the CDI files (each of 
which usually contains the full contents of a physical CD), can be inserted and ejected from any 
previously created virtual CD-ROM drive at will, using the insert and eject functions in the Image and 
CD Drive pulldowns.

CDI files can be created on any local drive or remote computer using the Create CD image function, 
and the Add CD Image function can be utilized at any time by the current computer or a remotely 
connected computer, to register the CDI file in the CD Manager database, thereby making the file’s 
data available to one of the virtual CD drives and Windows and Windows applications.

As long as the Windows operating system has access to the CDI file, that CD data can be utilized as a 
virtual CD.

CDI files can be stored anywhere on a hard drive. The locations and primary filenames of the files are 
defined when the CD image is first copied from its original location on the CD, to the hard drive, using 
the Create a CD Image function (see Section 2.3.2 ).
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6.2 Command line control of CD-ROM Emulator

Important: this chapter is only for advanced users! Be very careful while using command line control of 
CD-ROM Emulator.

You can use command line control to automate any process, which is linked with CD-ROM Emulator in
any way. The executable you need to reference is CDMAN.EXE. It’s the executable you need to start 
to open CD-ROM Emulator Manager window. However, in the command line mode the window won’t 
open, CDMAN.EXE will work in “silent” mode. CDMAN.EXE is located in the installation directory of 
the product.

The syntax:

cdman /command:cmd1<’>-”parameters”,cmd2<’>-”parameters”,...
or
cdman /c:cmd1<’>”parameters”,cmd2<’>”parameters”,...

Here are:
cmdx – command identifier, see below.
<’> - optional apostrophe, if used specify ignoring return values.
”parameters” – parameter(s) for particular command.

Command must not contain spaces (unless parameter is a filename), parameters must be in quotation 
marks. If an error occur while processing command line CD-ROM Emulator terminates and returns 
error code (see at the bottom). To ignore return value while processing the command specify 
apostrophe. Examples:

cdman /command:a-”G”,i-”G=d:\image.cdi”
In this sample if the drive G:\ already exists command line processing terminates with an error code.

cdman /command:a’-”G”,i-”G=d:\image.cdi”
In this sample if the drive G:\ already exists command line processing doesn’t terminate and the next 
command (‘i’) is processed.

Command identifiers:

A command: adds new virtual CDROM drive(s), the sequence of drive letters is not significant. The 
new drives are added as if with “For this session only” checkbox checked in the normal “Add new 
CDROM drive” dialog. The following sample adds two new drives R:\ and T:\ :
cdman /command:a-”RT”
R command: removes virtual CDROM drive(s), the sequence of drive letters is not significant. The 
following sample removes two drives F:\ and M:\ :
cdman /command:r-”MF”
M command: gets virtual drives mask. All commands following this one are ignored. The following 
sample returns drives mask as exit code:
cdman /command:m
Drives are encoded in the following way: drive letter A: corresponds to the lowest bit in exit code, drive 
letter B: - to the second bit and so on.

I command: inserts CD image in virtual CDROM drive. The image filename can be long filename with 
spaces and non-english characters. The following sample inserts image ‘C:\the image.cdi’ to drive 



G:\ :
cdman /command:i-”G=c:\the image.cdi”
E command: ejects CD image(s) from virtual drive(s), the sequence of drive letters is not significant. 
The following sample ejects drives G:\ and D:\ :
Cdman /command:e-”GD”

Error codes:

0 – Success,
1 – General error,
2 – Invalid function,
3 – Invalid handle (driver is not opened),
4 – Drive or file already exists,
5 – Invalid drive,
6 – File not found,
7 – Read/write error (I/O error),
8 – Invalid CD image file format,
9 – Image already inserted,
10 – Image version is not supported.
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7. Hints

1. Double click virtual drive with image in CD-ROM Emulator main window to eject image.
2. Drag&Drop: You can drag an image in the right pane and drop it onto empty virtual drive in left 

pane to insert the image in the drive.
3. Double click background of right pane to launch “Create Image” Wizard.
4. Double click CD-ROM Emulator icon in the tray bar to open or close CD-ROM Emulator main 

window.
5. To unload CD-ROM Emulator interface module: either choose Image|Exit menu command from 

CD-ROM Emulator main window, or right click CD-ROM Emulator icon in the tray bar and choose 
Exit menu command.
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8. FAQs

8.1 Why should I use CD-ROM Emulator rather than just copy files from CDROM to hard disk?  
8.2 How does decompression of CD image affect performance? 
8.3 How can I access virtual CD created on server from different workstations simultaneously? 
8.4 Can I copy copy-protected CDs with CD-ROM Emulator? 
8.5 What types of CDs does CD-ROM Emulator support? 
8.6 What operating systems can CD-ROM Emulator be used in? 
8.7 Can I specify a drive letter for virtual CDROM drive? 
8.8 The dialog "Add CDROM drive"  
8.9 The dialog "Add CDROM drive" has a checkbox "Mount for this session only".  
8.10 Where are images I see in the right pane located on my hard disk? 
8.11 When I try to remove CD image from CD-ROM Emulator, Im asked whether to delete image 
file 
8.12 When I run my system I always see an icon of CD-ROM Emulator in the tray bar 
8.13 How can I exit CD-ROM Emulator (for it even not to stay at tray bar)? 
8.14 After installation CD-ROM Emulator and rebooting Windows, I get the message "Cannot 
initialize port driver cdiport.pdr".  
8.15 Is or will the CD-ROM Emulator be able to save Audio CDs into MP3 format? 
8.16 What restriction does trial version of CD-ROM Emulator have? 
8.17 How can I change "Auto insert notification" option for virtual drives? 
8.18 What is the difference between Personal and Network versions of CD-ROM Emulator? 
8.19 I have Personal version of CD-ROM Emulator and try to insert the same image in two 
virtual drives. 
8.20 I have created image of the program CD. 
8.21 I have multi-CD program and have created images for all CDs.  
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8.1 Why should I use CD Emulator rather than just copy files from CDROM to hard 
disk? 

Q1: Why should I use CD-ROM Emulator rather than just copy files from CDROM to hard disk? 

A1.1: A lot of applications do not work if there is not its CD in CDROM drive. CD-ROM Emulator 
emulates physical device and the application considers it works from the real CD.

A1.2: CD-ROM Emulator copies audio tracks as well. Then they are emulated as real audio tracks.
A1.3: Having virtual CDROM drive is very advantageous because many applications would not run 

just from the folder on the hard disk. Such applications often rely on their original path.
A1.4: CD-ROM Emulator optionally creates compressed images. When original CD has a lot of small 

files, being copied as a directory such a CD will take huge amount of disk space because of the 
big cluster size on the hard drive. (How to change cluster size – see Paragon Partition 
Manager). Being copied as compressed image, such a CD will take much less space. 
Furthermore, compression does not affect performance very much. Compression ratio 
approaches 50%.
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8.2 How does decompression of CD image affect performance?

Q2: How does decompression of CD image affect performance?

A2: Decompression does affect performance but very slightly. Would real CD used, performance would
be affected much more due to time consuming seek operation which is necessary to read big amount 
of small files. However, you can turn off compression during image creation.
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8.3 How can I access virtual CD created on server from different workstations 
simultaneously?

Q3: How can I access virtual CD created on server from different workstations simultaneously?

A3: Some applications shipped on CDROM have licensing restriction so you cannot run them more 
than once. If this is not the case, then application can run from virtual CDROM drive unlimitedly.

1.You can use end user version of CD-ROM Emulator to emulate CDROM with image file on the 
network server.
2.Or you can emulate virtual CDROM drive on the server and then share this virtual device. But in that 
case you should use multilicense or network version of CD-ROM Emulator. (click here to read more 
about network version) End-user version of CD-ROM Emulator does not allow to share virtual CDROM 
drives as network resource.
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8.4 Can I copy copy-protected CDs with CD Emulator?

Q4: Can I copy copy-protected CDs with CD-ROM Emulator?

A4: In many cases – yes. But some new copy protection systems can mark every CD with unique 
markups or signs, and such CD can not be copied with CD-ROM Emulator. To probe whether CD-ROM
Emulator will be able to work with your particular CDs, you can try trial version of CD-ROM Emulator.
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8.5 What types of CDs does CD Emulator support?

Q5: What types of CDs does CD-ROM Emulator support?

A5: Now CD-ROM Emulator supports data CDs, audio CDs and mixed CDs (one with both data and 
audio tracks).
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8.6 What operating systems can CD-ROM Emulator be used in?

Q6: What operating systems can CD-ROM Emulator be used in?

A6: At the moment (Apr 10, 2000) CD-ROM Emulator works under MSWindows 95/98/NT/2000. 
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8.7 Can I specify a drive letter for virtual CDROM drive?

Q7: Can I specify a drive letter for virtual CDROM drive?

A7: Yes, during creating new virtual CDROM drive you can specify desired drive letter for it. However, 
you can choose this drive letter only among spare letters.
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8.8 The dialog "Add CDROM drive" 

Q8: The dialog “Add CDROM drive” has an option whether “Mount drive for this user only” or “Mount 
drive for all users (at system startup)”. What does it mean?

A8.1: This option is sufficient for network version of CD-ROM Emulator (however, can be used in any 
case). For the first case (Mount for this user) the virtual drive will be created and mounted after user 
logon the system. For the second case (Mount at system startup) the virtual drive will be created during
system initializing (before any user logon the system). So in the second case the virtual drive will be 
available for all users (in countercase – only for current user). For network version it’s recommended to
use second option: the system makes any local resource shared at system startup. If a virtual device is
created with first option (Mount for this user only) and then shared, the sharing information will be 
cleared upon nearest system shutdown or restart.
A8.2: If your particular CDROM drive has an image on network drive you should use “Mount drive for 
this user only”, because if this option is not used – CD-ROM Emulator will try to insert CDROM image 
at system startup when the system hasn’t yet mount network drive and will fail in inserting virtual CD.
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8.9 The dialog "Add CDROM drive" has a checkbox "Mount for this session only". 

Q9: The dialog “Add CDROM drive” has a checkbox “Mount for this session only”. What does it 
mean?

A9: If this checkbox is checked, this virtual drive will present in the system only till nearest system 
shutdown or restart. If this checkbox is not checked, the drive will be created again at each system 
startup, so you will have this drive “almost” permanently.

8. FAQs 



8.10 Where are images I see in the right pane located on my hard disk?

Q10: Where are images I see in the right pane located on my hard disk?

A10: Icons you see in the right pane are just links to real image files. The image files are located on 
your hard disks (or network drives). Usually their locations are specified during creating of them from 
physical CDROM. Also these real image files can be copied or moved after creating to any other 
location. The paths CD-ROM Emulator uses for “inserting” CDs into drives are those specified in “Add 
CDROM image” or “Create CD image” dialogs. After adding (or creating) CD image to CD-ROM 
Emulator database (right pane), the icon will be linked with that image file.
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8.11 When I try to remove CD image from CD Emulator, I’m asked whether to delete 
image file

Q11: When I try to remove CD image from CD-ROM Emulator, I’m asked whether to delete image file. 
What does it mean?

A11: You are given an option whether to delete only an icon (or a link) from right pane of the program, 
or also delete real image file. See also Question10 and CD-ROM Emulator documentation.
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8.12 When I run my system I always see an icon of CD Emulator in the tray bar

Q12: When I run my system I always see an icon of CD-ROM Emulator in the tray bar. Is it necessary 
for CD-ROM Emulator to be always loaded?

A12: CD-ROM Emulator window application is necessary for operations with image files and 
inserting/ejecting virtual CDROMs in/from virtual CDROM drives, and also to play virtual audio 
CDROMs. In any other case you can unload CD-ROM Emulator manager – see Q13.
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8.13 How can I exit CD Emulator (for it even not to stay at tray bar)?

Q13: How can I exit CD-ROM Emulator (for it even not to stay at tray bar)?

A13: Right click CD-ROM Emulator icon in the tray bar and choose Exit command, or select Image|Exit
in CD-ROM Emulator manager menu.
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8.14 After installation CD Emulator and rebooting Windows, I get the message "Cannot 
initialize port driver cdiport.pdr". 

Q14: After installation CD-ROM Emulator and rebooting Windows, I get the message “Cannot initialize 
port driver cdiport.pdr”. Why?

A14: Under Windows 95 OSR1 installation program of CD-ROM Emulator doesn’t work correctly. You 
can setup Windows OSR2 or manual install program driver cdiport.pdr. For detailed information contact
Support Service by email: support@paragon.ru.
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8.15 Is or will the CD Emulator be able to save Audio CDs into MP3 format?

Q15: Is or will the CD-ROM Emulator be able to save Audio CDs into MP3 format?

A15: Now it isn’t. We work around it. Check news on our web-site http://paragon-gmbh.com
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8.16 What restriction does trial version of CD Emulator have?

Q16: What restriction does trial version of CD-ROM Emulator have?

A16: It has 30 days work limit. You can create only one virtual CD-ROM drive. In full version you can 
create up to 23 virtual CD-ROM drives. Also you can’t add already created images, you can only use 
images created with the particular version on your computer.
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8.17 How can I change "Auto insert notification" option for virtual drives?

Q17: How can I change “Auto insert notification” option for virtual drives?

A17: As CD-ROM Emulator creates virtual CDROM drives with full functionality of normal physical 
drives, you can change “Auto insert notification” option for virtual drives in the same way as you do it 
for normal physical drives. For example, for Windows 9x operating system you need to open System 
properties (right click ‘My computer’ icon on desktop and choose ‘Properties’), switch to ‘Devices’ tab,
open ‘Properties’ dialog for desired CDROM device and click “Auto insert notification” checkbox.
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8.18 What is the difference between Personal and Network versions of CD Emulator?

Q18: What is the difference between Personal (Single-user) and Network (Multi-user) versions of CD-
ROM Emulator?

A18: Personal version of CD-ROM Emulator is designed to be used in end-user (home) environment. 
Network version is designed for network environment with shared image files. This is the normal case 
when CD-ROM Emulator is intended to be used in some office to create CD server. We recommend to 
place image files on office file server in network resource, install CD-ROM Emulator program on 
workstations, create virtual CD drives on workstations and load them with images from file server. In 
this situation Personal version will not allow users from different workstations to use the same image 
file, but Network version will. Also, Personal version of CD-ROM Emulator can use image files located 
on another computer through network, the only restriction is that this image file can be used only by 
one copy of CD-ROM Emulator simultaneously.
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8.19 I have Personal version of CD Emulator and try to insert the same image in two 
virtual drives.

Q19: I have Personal version of CD-ROM Emulator and try to insert the same image in two virtual 
drives. For the first drive everything works fine, but for the second the system returns “The system 
can’t open the file”. What is wrong?

A19: This is correct behavior for Personal version. You can insert the same image into several virtual 
drives only in Network version of CD-ROM Emulator. 
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8.20 I have created image of the program CD.

Q20: I have created image of the program CD. However, when I insert this image in virtual drive the 
program can’t locate it. What is wrong?

A20: Some programs rely on the drive letter from which it is installed. When working with such 
programs it’s recommended to install the program from virtual drive, not from physical one. In other 
case you need to manually reassign drive letters for your physical and virtual drives.
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8.21 I have multi-CD program and have created images for all CDs. 

Q21: I have multi-CD program and have created images for all CDs. Then I created virtual drive for 
every this image and inserted images into them. Now when I start the program it finds some CDs, but 
not all of them. What is wrong?

A21: The problem can be in the program. It can assume that there is only one physical CDROM drive 
in the system. Though the program can find it dynamically it expects other CDs to be in the same drive 
letter as the first one. Such programs would behave in the same way even if you attach several 
physical CDROM devices.
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